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Fixes - Version 17.101 12/2011
General
Resolved a delay users may experience when opening a new menu option from themainmenu.
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Enhancements - Version 17.101
General

Cumulative enhancements and fixes
SageMaster Builder version 17.101 is cumulative and contains all previous enhancements and fixes from version 17.1.

Internet access required for Sage Master Builder
SageMaster Builder features such as printing or efilingW-2s or 1099s, submitting enhancement requests, or downloading
periodic product or tax updates all require Internet access. To take advantage of these features, please ensure any
workstation or server that SageMaster Builder is installed on has access to the Internet.

During installation of SageMaster Builderversion 17.101, the computer serving as the Sage license server must be able to
connect to the Internet to obtain licenses. Once installation is complete, you can check out license uses for each computer
where SageMaster Builder is installed, then disconnect the Sage license server from the Internet.

Licensing
Some applications previously part of the SageMaster Builder core have been removed and are now sold separately. Any
modules previously owned will automatically be part of your current license information.

"Core" refers to the basic program, exclusive of the additional modules. Additional module licenses include:

1. Inventory

2. Document Control

3. Equipment Management

4. Estimating (already separate)

5. Service Receivables and Inventory (already separate)

With SageMaster Builder 17.101, we aremoving to a new License Administration program. The new License
Administration program will allow customers to utilize the licensed uses andmodules that they have purchased. For more
information on setting up the Sage license server in your environment, log on to the Sage Customer Portal and subscribe to
Knowledgebase article KB34858.

Your SageMaster Builder software automatically refreshes license information from Sage daily. The licenses give you
access to the various modules of SageMaster Builder. As you purchase or remove license activations, the Sage license
server automatically updates this information in your system. You can also select to update the licensing information from
Sage on demand.
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Fixes - Version 17.101
General

Cumulative enhancements and fixes
SageMaster Builder version 17.101 is cumulative and contains all previous enhancements and fixes from version 17.1.

Resource Center renamed to Info Center
The Resource Center, currently available in SageMaster Builder Help > Customer Resources and SageMaster Builder
Help > What's New > Resource Center, has been renamed to Info Center.

1-8 General Ledger Setup
The labels now display correctly in 1-8 General Ledger Setup when viewed at 125%.
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Known Issues and Comments - Version
17.101
General

Sage.CRE.HostingFramework.Service v3.2 has stopped working, error message is
received during licensing installation.
Windows Server 2008 R2 comes with .NET 3.5.1 loaded but not installed, so SageMaster Builder does not install it
automatically during installation.

If you attempt to install SageMaster Builder17.101 without .NET 3.5.1 installed, you will receive the followingmessage
during the licensing installation: “Sage.CRE.HostingFramework.Service v3.2 has stopped working.”When you click OK,
the installation continues but the services have not been installed, so SageMaster Buildercannot open. The
Sage.CRE.HostingFramework Service will not install unless .NET 3.5.1 has been installed.

To install .NET 3.5.1 on Windows Server 2008 R2:
1 In theServer Manager interface, select Add Features to display a list of possible features.

2 In theSelect Features interface, expand .NET Framework 3.5.1 Features.

3 Once you expand .NET Framework 3.5.1 Features, you will see two check boxes. Check the box next to .NET
Framework 3.5.1 and click Next.

4 In theConfirm Installation Selections interface, review the selections and then click Install.

5 Allow the installation process to complete and then click Close.

NOTE: Enabling .NET Framework 3.5.1may require a reboot.

Installation to a network drive from a local drive is no longer available
In previous versions of the program, such as Version 14.2, you could run installation twice, installing to your local drive and
then to a network drive to update system reports and report forms. Due to changes to the installer, you can no longer run a
second installation to a network drive. A second installation on a computer only reinstalls the program to the local drive
again.

You can, however, update system reports and report forms on a network drive during a local installation if an \MB7 folder
exists on a network drive.

Note fields in reports and exporting to Excel
When exported to Excel, the query will not display the field immediately after the line notes field “rdrpln.ntetxt.” When
editing the report form, place the line notes field at the end of the query.
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About network configuration and TCP Remoting Channel
SageMaster Builder uses the TCP Remoting Channel, a Microsoft .NET Framework component, to enable communication
among computers on a network. Certain configurations can potentially disable the communication:

l File sharing on computers running theWindows 7, Vista, Server 2008, and Server 2008 R2 operating systemmust
be enabled. To enable file sharing, follow the instructions in theWindows 7/Vista/Server 2008 Help.

l TCP communication requires the selection of port numbers that are not in use by other processes on the local
computer.

l Software firewalls running on the local computer can be configured to block processes from opening TCP ports,
which will prevent communication through the TCP Remoting Channel.

Configuring Sage Master Builder Hosting Framework TCP port number
By default, SageMaster Builder uses the TCP starting port number 48750. This number can be configured using an XML
file, Sage.CRE.HostingFramework.Service-InstanceConfig.xml, located under: \MB7\Programs

CAUTION: If you need to change the default port numbers for the SageMaster Builder Hosting Framework using the
Sage.CRE.HostingFramework.Service-InstanceConfig.xml file, youmust change it on every computer on the
network where SageMaster Builder is installed. In addition, after making this change, the SageMaster Builder
Hosting Framework on each computer running SageMaster Builder must be restarted.

NOTE: Consult with your IT administrator for alternative port numbers.

To change the port numbers:
1 InWindow Explorer, locate the Sage.CRE.HostingFramework.Service-InstanceConfig.xml under this path:
\MB7\Programs

2 Right-click Sage.CRE.HostingFramework.Service-InstanceConfig.xml, and open it with a text editor, such as Notepad.

3 Near the end of the file between the <StartingPort> </StartingPort> tags, locate the port number and change it.

4 Save and close the file.

5 Repeat steps 1-4 on every computer running SageMaster Builder.

Sage licensing (Sage Master Builder Hosting Framework) cannot auto-start on
Windows 7 Professional, Vista, Server 2008, or Server 2008 R2 Standard
The Sage licensing service (SageMaster Builder Hosting Framework) cannot auto-start on computers running the
Windows 7 Professional, Vista Business, Server 2008, or Server 2008 R2 Standard operating systems. If the service
stops, the program displays amessage advising you to take further action to resolve this issue.

Vista, Windows 7, and Server 2008, or Server 2008 R2 installation and mapped
drives
Mapped drives may not be available when installing on a computer running the Vista, Windows 7, or Server 2008 operating
systems. See theMicrosoft knowledgebase article about allowingmapped drives to display elevated users:
http://support.microsoft.com/kb/937624/

NOTE: If you need to install to amapped drive, install the program to a computer that is running another supported
operating system, such as Windows XP.

http://support.microsoft.com/kb/937624/
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Configuring third-party firewalls
During installation of the SageMaster Builder Hosting Framework, theWindows Firewall is configured automatically to
allow the SageMaster Builder Hosting Framework to act as a TCP server. If you use some other firewall, however, you
may need tomanually adjust some settings in the firewall in order to ensure proper operation.

You can use the following basic procedure tomanually configure theWindows Firewall to allow the SageMaster Builder
Hosting Framework to communicate with other computers. Use it as the basis for manually configuring other third-party
firewall products.

To configure the Windows Firewall:
1 Click Start > Control Panel > Security Center (XP) orSecurity (Vista/Server 2008) orSystem and Security
(Windows 7).

2 OpenWindows Firewall, and select theExceptions tab (XP) orAllow a program or feature through Windows
Firewall (Vista, Windows 7, and Server 2008).

3 If Sage Service Host is not on the list, then you can add it by selectingAdd Program, then browsing to the following
path:
\MB7\Programs\Sage.CRE.HostingFramework.Service-InstanceConfig.xml.

NOTE: By default, the exception is set to allow access by any computer on the network. If desired, you can refine
this setting by selecting theChange Scope button. Be aware that restricting the scope incorrectly can cause the
computer to be unable to connect with some or all of the other machines on the network.

Help > About Sage Master Builder
“SageMaster Builder Standard” has been removed from theHelp > About Sage Master Builder window to avoid
confusion with other Sage products.

Read this information if you use ClearType smooth fonts
If your screen display properties are set for using ClearType smooth fonts, text on any SageMaster Builder window may
appear to be smudged or blurry. If this condition exists, use the following instructions to change the setting.

1 Right-click theDesktop, and select Properties.

2 On the Display Properties window, click theAppearance tab, and then click [Effects...].

3 On the Effects window, clear the check box, Use the following method to smooth edges of screen fonts.

4 Click [OK], and then click [Apply] and then [OK] again. Youmay have tominimize thenmaximize SageMaster Builder
for the changes to take effect.

PCI DSS Compliance
PCI DSS stands for Payment Card Industry Data Security Standard. It was developed by themajor credit card companies
as a guideline to help organizations that process card payments to prevent credit card fraud, cracking, and various other
security vulnerabilities and threats. A company processing, storing, or transmitting payment card datamust be PCI DSS-
compliant or risk losing its ability to process credit card payments and being audited and/or fined.

SageMaster Builder does not currently process credit card payments; however, two SageMaster Builder windows provide
data entry fields for credit card numbers and related information:

l 3-6 Receivable Clients, Payment Information tab, underCredit Card Information

l 11-2 Work Orders/Invoices/Credits, Invoice Details tab, Card/Check# field.
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In addition, youmay have created user-defined fields to store credit card numbers.

To avoid any non-compliance with PCI DSS, we recommend against storing credit card information in SageMaster Builder.
Such storage does not comply with the PCI DSS, and it creates a possible risk for your business.

For more information about PCI DSS standards, click the following link:

https://www.pcisecuritystandards.org/

Locating tax updates
Tax updates are released throughout the year. To get the latest information about tax updates, log on to the Customer
Portal, www.sagecre.com/customerlogon.

Then click Support > Documents > For Customers > Sage Master Builder > Release Materials.

Windows 7 Professional and Server 2008 R2 Standard Operating
Systems

Launching Sage Master Builder to run as administrator for scheduling reports

IMPORTANT: On computers runningWindows 7 Professional or Server 2008 R2 Standard, scheduling SageMaster
Builder reports requires that you to “run as administrator” or to “run the program as administrator.”

Microsoft Windows has changed security rules in theWindows 7 Professional and Server 2008 R2 Standard operating
systems tomake your computer more secure. If you are running SageMaster Builder as a typical user, then you have
limited privileges in some areas of the program, such as saving a report schedule. To save a report schedule, youmust
launch SageMaster Builder with the command to either Run as administrator or Run this program as an administrator.

When you select either command, the settings are limited to you personally. Your settings to run SageMaster Builder as
administrator do not affect the next person who logs on and launches SageMaster Builder from this computer. Your
settings on this computer can either be temporary or persistent. For example, when you select Run as administrator, you
run the program as administrator for that session only. When you select Run this program as an administrator, you set
program properties to always run the program as administrator when you log on to this computer.

NOTE: "Run as administrator" and "Run this program as an administrator" are not related toWindows 7 Professional
or Server 2008 R2 Standard operating systems user groups but are limited to a specific program you are running.

To set "Run as administrator":
1 On yourWindows desktop, right-click the SageMaster Builder program icon.

2 From the drop-downmenu, to launch the program, click [Run as administrator].

NOTE: SelectingRun as administrator only runs the current session of running SageMaster Builder. The setting
does not persist after the session is over.

To set "Run this program as an administrator":
1 On yourWindows desktop, right-click the SageMaster Builder program icon.

2 From the drop-downmenu, click [Properties].

3 On the SageMaster Builder Properties window, click the [Compatibility] tab.

4 Under Privileges Level, select Run this program as an administrator.

5 Click [Apply], and then click [OK].

https://www.pcisecuritystandards.org/
http://www.sagecre.com/customerlogon
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NOTE: SelectingRun this program as an administrator always runs the program with these properties when you
launch the program on this computer. The setting persists.

Windows 7 Professional and Server 2008 R2 Standard "Sleep Mode" prevents
computers from obtaining a license use
If a computer running theWindows 7 Professional or Server 2008 R2 Standard operating system is used as a license
server, when it goes into sleepmode other computers on the network can’t obtain a license.

Set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to “Never:”

1. Start > Control Panel > System and Security > Power Options.

2. Select Change when computer sleeps.

3. From thePut computer to sleep list, select Never.

Solution for Server 2008 R2 "Permission Error Opening File"
If you see an permission error message when launching SageMaster Builder on a computer running theWindows Server
2008 R2 operating system, follow these instructions:

1 On theWindow desktop, right-click Start, and then click Open Windows Explorer.

2 On the left side of the window, underComputer > Local Disk, right-click the \MB7 folder, and then select Properties.

3 On theMB7 Propertieswindow, click theSecurity tab.

4 From the list underGroup or User Names, select USERS, and then click theEdit button.

5 On thePermissionswindow, select USERS again, and underAllow, select the Full control check box.

6 Selecting Full control selects all the check boxes necessary for this solution.

7 On thePermissionswindow, click OK, and then on theMB7 Propertieswindow, click [OK].

Windows Server 2008 R2 and Microsoft .NET 3.5.1
Microsoft .NET 3.5.1 must be available and enabled prior to installing SageMaster Builder version 17.101 on aWindows
Server 2008 R2machine. Server 2008 R2 comes with .NET 3.5.1 loaded but not installed, so SageMaster Builder doesn’t
install it automatically.

If you attempt to install SageMaster Builder 17.101 without .NET 3.5.1 installed, you will receive the followingmessage
during the licensing install: “Sage.CRE.HostingFramework.Service v3.2 has stopped working.”When you click [OK], the
installation continues, but the services have not been installed so SageMaster Builder cannot open. The
Sage.CRE.HostingFramework Service will not install unless .NET 3.5.1 has been installed. If you receive the above
message during the installation of 17.101, install .NET Framework 3.5.1 and reinstall SageMaster Builder.

To verify that .NET 3.5.1 is installed on Windows Server 2008 R2:
1 Click theStart button in the lower left hand corner of the display.

2 Highlight Administrative Tools and select Server Manager.

3 In theServer Manager interface, click Features to display all the installed Features in the right-hand pane. Verify that
.NET Framework 3.5.1 is listed.
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To enable .NET 3.5.1 on Windows Server 2008 R2:
1 In theServer Manager interface, select Add Features to display a list of possible features.

2 In theSelect Features interface, expand .NET Framework 3.5.1 Features.

3 Once you expand .NET Framework 3.5.1 Features, you will see two check boxes. Check the box next to .NET
Framework 3.5.1 and click Next.

4 In theConfirm Installation Selections interface, review the selections and then click Install.

5 Allow the installation process to complete and then click Close.

NOTE: Enabling .NET Framework 3.5.1may require a reboot.

Windows Vista and Server 2008 Operating Systems

Solution for Server 2008 "Permission Error Opening File"
If you see a permission error message when launching SageMaster Builder on a computer running theWindows Server
2008 operating system, follow these instructions:

1 On theWindow desktop, right-click Start, and then click Explore.

2 On the left side of the window, under Folders, right-click the \MB7 folder, and then select Properties.

3 On theMB7 Propertieswindow, click theSecurity tab.

4 From the list underGroup or User Names, select USERS, then click theEdit button.

5 On thePermissionswindow, select USERS again, and underAllow, select the Full control check box. Selecting Full
control selects all the check boxes necessary for this solution.

6 On thePermissionswindow, click [OK], and then on theMB7 Propertieswindow, click [OK].

Vista and Server 2008 “Sleep Mode” prevents computers from obtaining a license
use
If you are using a Vista or Server 2008 computer as the Sage license server and it goes intoSleep Mode, the workstations
cannot obtain a license use.

Use a different computer on your network to be the Sage license server. Any supported operating system can be used in
place of Vista or Server 2008, for example, Windows XP.

Set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to Never:
1 Start > Control Panel > System and Maintenance > Power Options.

2 Select Change when computer sleeps.

3 From thePut computer to sleep list, select Never.

Vista, Windows 7, and Server 2008 and changing the Sage License Server
computer
On a Vista, Windows 7, or Server 2008 workstation, when you select File > Change Sage License Server > Select the
computer from the list of computers on your network, the commandmay fail to generate a list of network computer
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names. To resolve this issue, click Enter the IP address or name of the computer, and then type the IP Address of the
server computer in the box.

Possible conflict when running scheduled reports on Vista Business 64-bit
operating system
On computers running the Vista Business operating system, the SageMaster Builder report scheduler may encounter a
conflict with theMicrosoft print spooler (splwow.exe) andmay not function as expected.

A solution for avoiding this possible conflict would be to schedule reports on computers running a 32-bit operating system or
on computers running the XP 64-bit operating system.

Reports

Earlier versions of reports and form designs created or saved in Version 14 or
later
Due to the technology changes in Version 14 and later:

l Version 13 and earlier reports and form designs that have been edited or saved in Version 14 or later will no longer
work in Version 13 or earlier releases if copied back to Version 13 or earlier releases.

l Reports and form designs created in Version 14 or later will not work in Version 13 or earlier releases.

Custom Reports

SQL query (calculated fields) formatting issues
The SageMaster Builder program code was upgraded from Visual Basic to .NET C# in Version 14. The CodeBase engine
has also been upgraded to .NET.

The Visual Basic CodeBase engine in Version 13 and earlier was very forgiving when handling improperly formatted SQL
queries and would often execute these reports; however, the results of these queries may have been different than
expected. The .NET Codebase version strictly enforces proper SQL formatting and will not execute reports with improperly
formatted SQL queries.

To help resolve this issue in v14.2, the development team added validation to check the SQL formatting when saving or
executing custom reports. If the CodeBase engine cannot interpret the SQL query, the program displays amessage telling
customers the name of the calculated field so that they can open the report writer and locate the problem and correct.

Font issues
SageMaster Builder uses Arial font as the default font for the reports and form designs that are delivered with the program.

SageMaster Builder itself does not limit the fonts used on custom reports except that they must be TrueType® fonts. If the
font is installed on the system, SageMaster Builder attempts to use it. In testing, however, the development team
discovered that the .NET environment is muchmore restrictive with fonts and the font properties (for example, bold, italic)
than is the Visual Basic environment.

In the Visual Basic environment of Version 13 and earlier, if a font did not exist on the system, the program located and
substituted another font. If the specific font was installed on the system but the font properties were not supported, the
system would also substitute another font. The .NET environment of Version 14 does not locate and substitute another font
or font properties, but rather displays an error message.
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In Version 14, the development team added validation to the program code to recognize this issue and display amessage
so that customers can correct the font in the report as necessary.

The program attempts to substitute the font using Arial to allow the user to execute the given report after themessage has
been cleared.

Slight changes to field locations on reports can cause sizing issues
Themigration from a Visual Basic environment to a .NET environment required the development team tomeasure report
formatting with pixels rather than twips. Because of this change, a few data-field locations had to be adjusted slightly on
some reports. Most of the reports still work as expected without any data-field location adjustments. If you encounter this
formatting issue on any of your custom reports, open the report in Report Writer and adjust the field locations as necessary.

Note field issues related to their placement on their own line in custom reports
When note fields are included with other fields on the same report line, they may or may not work as expected. For many
years, SageMaster Builder reports have required that Note fields be placed on their own individual report line to ensure that
they would word wrap and paginate properly. All installed SageMaster Builder reports were designed tomeet this
requirement.

These steps provide the best solution to this problem in a custom report:

1 Move the note field to its own line directly under the line that the notes are related to on the report.

2 Set the properties of this field toDo not print the line if the value returned for this field is zero/blank.

3 Set the number of characters to 32767, and then set the format toAuto.

Faxing and Adobe Reader

Use Adobe Reader Version 8.1.3 or later for faxing
Customers have reported problems faxing from SageMaster Builder with versions of Adobe Reader earlier than 8.1.3. Note
that Adobe Reader Version 8.1.3 and later support faxing fromWindows and from SageMaster Builder.

IMPORTANT: To fax from SageMaster Builder, theWindows Fax Service component must be installed with your
Windows operating system. For more information about installing theWindows Fax Service component, see the Sage
Master Builder Help topic, “Installing theWindows Fax Service component.”
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